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Introduction

IMan was designed primarily as a logging tool. During an emergency incident
reasonable efforts should be made to capture as much information as
possible. Research has shown that on a typical SAR Incident the capture rate
of actual information generated can be lower than 50%. Low capture rates
create difficulties when there are multiple management teams and handovers,
in insuring that incoming teams have access to all of the information they
need to make sound decisions.

We believe that with effective management strategies and tools such as IMan
it is possible to aim for a capture rate of 80-90%.

We know from experience that a high capture rate makes a huge contribution
to the effective management of an Incident. It can also be a significant
indicator of the effectiveness of a management team.

Program Concepts

There are many similarities in the concepts and processes used in IMan and
GMan. The similarity is intended to allow users to transfer their understanding
when using both programs. It also stems from the fact that much of the GMan
functionality was derived from IMan to improve user transfer of skills.

Key Program areas
The key areas of the IMan screen are shown below.

Icon Bar Menu Bar Program Title Bar

B [Man - User: Barry Were - Role: Tiainer - [Incidents : Operation Hopegood]

:]I Ele Show Reports Options Help — | &=
Main | Search
Mame
-«
Type = Search Area

Inciderits St ’—L| Search | Clear ‘

&

Resources MName |Type |Status |
Operation Hopegood Search and Rescue Open |
Te Tapui SAREx Open

"

b & 2
TN

'_
=}

1=
@

Maintenance

-~ i
Location |Dperation Hopegood Detall Area

Adrni

Icon Bar Sections
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The Program Title Bar shows the following:
The program name (IMan or GMan)
The user name and designated role of the person currently logged on
The name of the current screen
The selected Incident name
This information is displayed so that users and administrators can see this
important information at a glance.

The Menu Bar presents a variety of functional options to users. Some of the
menu items change depending on the Icon selected. For example when the
Resources and Teams Icon screens are selected the Show menu option is
not presented. The reason is that there are no Search and Detail areas for
these two screens.

The Icon Bar is used to select the screen to be used. There are three ways to
tell which Icon is selected:

The yellow outline of the Icon symbol

The word displayed on the Title bar

The Icon displayed to the left of the Menu bar.

The Icon Bar Sections provide access to extra Icons depending on the rights
of the current user. The Icon Bar Sections provided are Main, Maintenance
and Admin.

The Main section provides access to the core user screens

The Maintenance section is used to add and edit details of People,

Equipment and Locations

The Admin section is used to manage the drop-down lists and users

The Search Area is used to determine the items displayed. This is the same
as creating a filter.

The Help option displays the program details on an “About” screen.

Key
information
on this screen
includes the
Version
number and
the file and
folder name
of the
database.

To view the full details for an item on the Teams, Tasks or Logs search results
screens use one of the following:

Double Click anywhere on the item line

Right mouse click anywhere on the item line
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Select the line and press Control E

The Show Menu option turns on/off:

Criteria (Search) area — at the top of the screen

The Detail section at the bottom of the screen.
By turning either or both of these options off more items can be displayed on
the screen.

The 3 items in the Options menu are New, Edit and Delete. Their shortcuts
are Control N, Control E and Del (the Delete key) respectively.
In most IMan screens a new record is added by pressing Control N.

Other Shortcuts

Throughout the programs shortcuts are available that use the Alt key and a
single letter. These are indicated on screen by the underlining of the letter to
be pressed with the Alt key.

The Reports menu provides access to a variety of reports dependent on the
Icon selected. The export options create web based Htm files. These are
saved to the folder location specified on the Options screen for the Export
Path. This file can be printed or emailed or the contents copied to a Word file.

The File menu option is discussed later.

The Maintenance Icon-bar Section
Normally these screens are populated with data imported from GMan.
The three main screens being People, Equipment and Locations.

B |Man - User: Barry Were - Role: Trainer - [Groups Maintenance : Te Tapui]
5 File Show Options -8 x

Main | Search

I ain |
ainl anance| Group | [ Clear ‘

S

Locations Groups |
IEI Hamilton 4R Group |
Tasman SAR
Peaple Taupn S4R Group
M Thames 54R Group
Turangi S4R Group

Enuipment ‘wiaitorno SAR Group

Groups

When an item of equipment or a person is available at an incident but has not
previously been entered into GMan then these screens are used to record
their details.

The GMan screens have almost identical layout and functionality to the
screens associated with the Maintenance Icons.

The Group Screen is provided so that the same IMan and GMan files can be

used to manage the resources (membership and equipment) of multiple
Groups.
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People

IMan provides several screens that can display the full details recorded for
people. The screens are People, Resources and Teams.

Man - User: Barry Were - Role: Trainer - [People Maintenance : Training1] |
ile Show Reports Options = | & X
tain Search

Maintenance: Mame SEFP - Age less than
Expiry Date before | SEP 57 Age mare than
= Status v SER v Role v

Locations

Search Type « 0R O AND SEP Search Type I OR & AND T | Clear ‘
Resuljz): 72
People
First Mame Surnarne |A Skills
M Dylan e _;‘Desc:liption" |_,‘ Date |_,‘ Date Expires |_,‘ Comment |A
Equipment Elijah Fiobinzon P |First 4id Std 1/06/2001 |
Emm Tirae Mini S4F 1 1/04/2000
Em wilson Mini S4F 2 5/08/2000
Groups Eri Foss Shd 140272002 "
A P T,?A 4 + 104 nnn
Jahnson Ezperience
an
5 e _;‘Description" |_;‘Date |_;‘Date Expires |_;‘Eomment |
. van oo
Click here to : > |
Evan Lewiz
change sort order  [Geuge Miller
Grant Moz
Haypden Anderzon
IHuEtT[ \F:Trez Positions
Jsa : C ke _# Description® |_,‘ Date |_,‘ Date Expires |_,“ Comment |
ac 0% > |
Jade Gonzales
James Calling
T
- John Fhillipz B
Admin |

To change the order that the names are displayed click on the First Name or
Surname column heading. The first click will sort the names in ascending
order. The next click will reverse the order. This sort facility is provided on
most screens.

Edit details : To edit or review the details of a person:
Right mouse click on the name, or
Double click on the name

To add a new person to this screen press Control N.
The details screen will open — this has six tabs for entry of the details relevant
to the person.

All fields that are required to have an entry in order to save the new record are
marked with an asterisk (*). For people the only required field is Surname.

A photo can be displayed for the person. Click in the photo area to select the
photo to be displayed. This links to the folder selected in the File/Options
screen. A click on the Open Photo button will enlarge the photo in the default
photo viewer — usually Windows Picture and Fax Viewer for Windows XP
systems. Only one photo can be stored per person.

The IMan Import tick box (in GMan) determines the records that will be

imported into IMan.
The Role field provides an indication of the role best suited to the person.
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As with all drop-down lists the options available for the Role field are set in the
Admin Icon Set area.

(T Edit Re =)

Details T Details 2 T Mext OF Kin T E quiprnent T SEPs T Groups

First Mame |Emma Surname® |Wi|$u:un

Gender " Male (" Female Decupation |

Harme Phohe 07 824 7RET obile Phone
Wwhork Phone Pager

Home Addrezs  |Po Bow 632 Woork Address
Hamiltan
Emai | Phato
] [click inzide the

Email 2 | photo area to

change the
Statuz |.-'1'u:tive ﬂ phata)
Awailabiity | Open Photo
Organization | ﬂ
From 0

: an
Rale |L|st ﬂ Import v
Cormments Delivery: Post
Save, Lieate Save, Cloze Save ‘ Cancel
Hew

The Equipment tab is used to record the details of items owned by the
person and generally made available for use during an Incident. Since these
items are not normally available for allocation to teams and there is no
provision for the check in/out of these items.

The SEP tab records the Skills, Experience and Positions associated with the
person.

Skills relate to quantifiable training such as courses attended which have an
assessment component.

Experience records activities attended that help to develop the expertise of
the person. Practice exercises are likely to fit this category.

Positions record experience gained by the person in filling specific roles and
also provides an indicator of the roles a person would be suitable for.

These three categories are used to assist in the selection of team members to
ensure that each team has an appropriate mix of skills and experience for the
task set for them.

The expiry date is used for assessed training such as First Aid which expires
after a period of time. This assists the training coordinator to keep track of the
training requirements of the members.

There is no limit to the number of SEP entries for a person.
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The Search

Most of the Icon screens in IMan have a search area. The fields available for
the search are specific to the screen and reflect those most likely to be
required in a search.

The concepts described below are common to all search areas.

Search

Name | SEP - Organisation Age less than
Expiry D ate before i SEP - E quipment M ame Age mare than
Status - SEP - Fole -

i v i 0
Search Type 0R AND SEP Search Type ©° OR AND Geerth Clear ‘
Fesul(s]: BB

The Name area will accept any characters and will look for those characters in
both first name and surname. Examples:
bel will find Isabel
il will find Emma Wilson and Riley Garcia
David w will find David Wilson
em%son will find any combinations of names with em and son
including Emma Wilson

Text entries on the search screen are not case sensitive.

The Status and Role field contents can be selected from the drop-down lists
or characters can be typed in.

The Search Type AND and OR functions control the logical relationship of the
search when more than one field, such as Name and Status, are included in
the search.

The same AND/OR option is provided specifically for the 3 SEP fields.

The search options based on Age makes use of the Birth-date field on the
Details 2 tab.
Result(s): indicates the number of people who meet the search criteria.

A click on the Clear button will remove all search criteria and display the full
list of people available.

People Reports

The reports available for each screen change to match the requirements of
each Icon screen. The options available through the Reports menu for
People are shown below.

n File Show WEsige8 Options B B
""" wan | BETTEEm | Most reports will only include the
Maintenance Contact Details Summary 4 names/details listed on the screen at the
Detail For Selected Person . . .
@ People With A Certain SEP 4 time. Thus a search is used first to select
Locations Export Summary Report 5 the peOp|e tO be InC|Uded On the I’epOI’t
IEI ExportContfactDetaiIs Summary Report B For people the Summary and Contact
Export Detail Report 3 )
Pecple Export People With A SEP Report Details Summary will use the search
=9 [c results.

The reports that export their results will create HTML files which can be
copied into Word or Excel. The folder used for the exported reports is

Page 8



specified on the File/Options screen. The file location and name are displayed
on a dialogue when the export is successfully completed.

IMan X]

L3
‘!I‘) Export complete, Report exported to: C:'aTempiIMan'People Summary 22_May_2006 15_27_06.htm

Each report exported is given a name which includes the date and time. This
insures that running a report again will not overwrite previous versions.

Where the search results cannot be made specific enough to select the exact
records to be included a multi-select process can be used as shown below.
This uses the standard Windows multi-select processes as follows:
Using the Shift key. Click on the first record to be included, then hold
the shift key and click on the last record. All records in between
(including the first and last) will be selected
Using the Control key. Hold the Control key down and mouse click on
any records to select or deselect as required.
The two keys can be used to create a selection similar to that displayed
below.
When multiple records are selected a Right Mouse click on any of the
selected records will display the menu options shown below.

These reports will only

m Options Apply To The Selected Records InCI Ude the SeIeCted
records.

Wiew Summary Repart
View Contact Details Summary =
View Detail Report I

Copy To Clipboard
Save As Excel File
Save As Database
Save As HTML
Save As Text File
Save As M5 Word (requires M3 Word to be installed) ];

[*]
Gonzales |

Anderson

Ramirez

Wwallace
Con

Equipment Icon

This area records details of all equipment available and/or owned by an
organisation for use during an Incident. Equipment can include radios, GPSs
and computers. Details of vehicles, heavy machinery and specialist items may
also be included. There is no limit to the number of items that can be stored.
The availability of contact details for each item can assist in the mobilisation of
equipment when needed.

A photo of each item can also be attached to the record.

It is important to list all items available to be issued for teams to take into the
field.
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7.3 Edit Record

Name* |Riadios VHF Handheld Serial Mo, |
Drezcription |Ic:|:|m F&0 Drier |HSI3
Comments Enzure that all radios are iszued with a Floppe Jim aerial.

Contact M ame |Eevan W alue $(1000

Emnai | Phata
[click inzide the
Home Address | phato area to
change the
Wwork Address | phiota]

Avalabiity | Open Phata
Home Phone YWiork, Phone

Mabile Phone Pager
[uantity” 5

Save, Create

Cancel
Mew

Save, Cloze

Locations Icon

Location details are also considered to be a resource and like the rest of the
icon screens in the Maintenance section are normally recorded by the person
keeping the training records using GMan.

Locations recorded may include huts, helicopter landing sites, track junctions
river entry/exit points, repeater sites etc.
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There is no limit to the number of locations that can be recorded. The more
info that is stored against each location the better.

The Grid Calculator button (GC) produces the following screen:

The values used for the calculations are picked up from the IMan fields but
the results need to be highlighted, copied to the clipboard then pasted back to
IMan.

The Grid calculator allows conversions between the common datum’s
available throughout the world.

The DM button is for Degrees and Minutes while the DMS button is for
Degrees, minutes and seconds.

WGS84 is the default datum on most GPS units and especially the GPS
devices used in aircraft. The horizontal distance between identical Lat/long
cords in WGS84 and NZGD49 is only about 200m.

In NZ the WGS84 Lat/Long values are expressed as South and East.
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MG provides a selection of Map Grid options.

The data entered into IMan for Locations, People and Equipment cannot be
exported back to GMan.

Incident - Main Section
For each new incident the relevant details should be entered into this screen.
If time is short during the initial stages of an operation the key details to enter
are:

The Incident name

The Incident Type

The Lowest Map Ref Easting and Northing values

The rest of the details can be entered later as time permits.

Most of the information provided on this screen is printed on the Team
Tasking report. The fields not included are:

Person Details

Lowest Map Ref and GR Increment Below 500
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The Lowest Map Ref Easting and Northing values are used on the Logs
screen to convert a 6 digit grid reference to a 14 digit GR. The two numbers
needed can be found from a topo map of a mapping program such as
TUMONZ.

The six digit GR is the value generally derived from a topo map by parties in
the field. Search teams usually convert a 14 digit GR from a GPS to a 6 digit
GR to reduce the radio traffic.

IMan will convert the 6 digit GR to 14 digits as follows.

If the values entered on the Incident screen for Lowest Map Ref are E=27
and N=64 then a GR of 426941 will convert to 2742600, 6494100

For New Zealand the Easting values are in the range 20 to 30. The Northing
values range from 53 to 68. Since these values represent a 100km range (eg
22 to 23 is 100km) it is unlikely that a normal search will span more than one
100km area.

However a search may be on or near the line where the number changes
from say 22 to 23. When this occurs it is necessary to tick the GR Increment
Below 500. If they are both ticked then the GR of 426941 will convert to
2842600, 6494100.

If these GR values are not sorted early in the operation it can be a tedious
task to update all the GR values in the Logs screen later on.

The Last Log Printout indicates the last time the complete unprinted section
of logs was printed. The facility to set up a reminder at predefined periods to
print this log is provided in the File/Options screen. This print out provides a
backup in the unlikely event of a catastrophic computer failure.

Resources

The Resources screens are used to track people and equipment associated
with the operation. This means that each person and item of equipment is
Checked In on arrival and Checked Out when they depart.

The people and equipment must be checked in before they can be allocated
to teams.

The check in process relates to peoples availability for the operation. When
people are sent into the field they are tracked elsewhere in the program. It is
only when they depart the operation to return to their homes that they are
checked out.

The check in process also allows a report to be produced showing the total
hours of involvement of each person.

The People in Database area (bottom left corner) shows all people who are
likely to attend. These names are usually imported from GMan. If a person
arrives who is not listed then go to the Maintenance Section People screen to
add his/her detalils.

To Check people in:
Double click on the name, or
Click on a name then the Check In
button, or
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Multi-select names (with shift and Control + mouse clicks) then click the
Check In button
A small screen appears that asks for confirmation of the date/time of check-in.
This allows for the Check In/Out of people after the event. The date and time
entered must be consistent with the default value (the current date/time)
displayed to be accepted.

The Filter button at the top of the screen hides all those people who have
already been checked out.

The Count number displayed shows the total number of names on the list and
changes when the Filter button is clicked if some people have already been
checked out.

The check out process is the same as the check in where multi-select can
again be used with the Check Out button. This applies to the names on the
top half of the screen.

Once a person has been checked in the time cannot be changed. If a mistake
has been made then the person can be checked out then deleted (by pressing
the delete key or double clicking the name again). They can then be checked
in again with the correct date and time.

The only difference with Equipment is the facility to manage the Quantity.
By clicking on the cell below the | | button another small
screen opens that allows the guantity to be changed.

The sort order of the people and equipment can be changed by clicking on the
grey column headings.

Teams

By creating all the Team names that are likely to be used early in the event
the shortcut keys can then be used when creating log entries. Default Teams
can be set up in the Admin area to populate this team screen when a new
Incident is created.
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Assigning people to a team is performed in the same way as people are
checked in and out except the multi-select facility is not available.

Any person selected on this screen will have their SEP details displayed at
the bottom right corner. This means that selecting a person in People
Assigned or People Available will display their SEPs. Right mouse clicking on
a person will open their full details screen.

Once a person has been allocated to a Team they can then be allocated a
Role. The drop-down list of role options is set in the Admin area.

The Filter/Unfilter button changes the list of available people. When Filter is
displayed on the button the list is in the “unfiltered” state. This means all
people checked into the incident are shown on the list.

When Unfilter is displayed the only people on the list are those who have not
been allocated to a team.

People can be allocated to more than one team although the system will
provide a warning message.

The Printer Icon above the Assigned People produces a detailed report
for the current selected team.
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The Detail tab shows the

history of the team’s
membership.

The Check In/Out columns
relate to membership if the
team rather than
availability to the Incident.
Also shown is the most
recent Task allocated with
location, status and time
details.

The Equipment tab is
used to allocate items to
the team from the

common pool of items. This does not include items of equipment owned by
people attending the event unless those items have been entered into the
equipment screen (in the

resources section) and

checked in to the Incident.

The pen symbol beside
Quantity and Item ID
column headings indicates
that these fields can be
edited. If a quantity is
changed it is important to
click elsewhere on the
screen (on another record)
after the change has been
made so that the values
will be updated correctly.
When the quantity
assigned is edited the
corresponding available
Quantity Left will change
automatically.

The Item ID field is used to store the serial numbers or other identification of
items such as radios.
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Tasks

The top portion of this screen has the search criteria. This determines the
Tasks to be listed on the screen below the search area.

A Task can be selected by clicking on it with the mouse. When selected the
background of the entire line changes to blue. The up/down arrow keys can
be used to change the selection to a task further up or down the list.

Key fields for the selected Task are displayed in the bottom section of the
screen.

Options to open a selected Task are:
- Double left mouse click on it
Right mouse click on it
The Control E key combination
Click on the Options menu and Edit
The key combinations of Alt O (to select the Options menu) then the
letter E

Similarly to create a new Task:
- The key combination of Control N
Click on the Options menu and New
The key combinations of Alt O (to select the Options menu) then the
letter N

To Delete a Task:
Press the Delete button
Click on the Options menu and Delete
The key combinations of Alt O (to select the Options menu) then the
letter D
A screen will appear to ask for confirmation of your intention to delete the
Task. Tasks are only hidden — they are not removed from the database
however they can only be restored by the team at Datasolve.

Only users with Administrator rights can delete Tasks.

Once the Task screen is opened (as below) there are many features to
consider.

The two fields which must have content in order to save a new Task are
Description and Status, as indicated by the * (asterisk).

The Last Update field is automatically updated each time a Task is saved.

The Assigned To field details can be entered in several ways:
Click in the field with the mouse then click on the drop down list symbol
to choose from the list
Type in the shortcut associated with the team name
Type in free text — the contents do not need to come from the list

The drop down lists for the Status and Priority fields can be changed in the
Admin area.
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The radio related

fields of Simplex  JERAlAES s
Chan., HF and Details Il Audit Log
SChed Tlme are Dezcription® |SignEutTrig Last Updated |
incl with th
ra dil:)dgstails One Cammenced |1930932003 Ehmazun am ﬂ Completed |9mmnus E |1;41;30 . ﬂ
the InC|dent Type |3upport j Status* |.~'5«||Dc:ated j
screen on the hssared o [Team15 [ oy [Low ~l
Team TaSkmg Simples Chan.  |Ch 1 HF M Sched Time
report.
W Tranzport Details
The Transport Tramzpart  Helicopter  Tasking Mo. l— Fram ’— i
Tl
b e " Road / 4wD
Details fields are - B°at To -
for the | ETD | ] | *

management of
transport
resources. The
reports should be
suitable to hand to
the helicopter
pilots, boat
operators etc.
This area of the
program is still
being developed.

- Location Details |Pir0ngia Sumimit

Dretails Pracaed ba trig and sign cut tig)

Hazards /
Considerations

Mo known hazards

Task No. |3 &&| Logll 114 Savx;, Create
Mew

Save, Close Save

| Cancel ‘

The Grid Calc. screen does not return any values to this form.

The

buttons are used to expand/collapse the Transport and Location

sections of the screen.

For the Location Details a grid reference or location description can be typed

directly into the field. Alternatively, by clicking on the button a location can

be selected from the list imported from GMan.

The Task No. is a unique sequential number allocated by the system to each
new Task. Similarly the Log Ul is the number allocated from the Logs area to
the Log entry for storing the original Task details plus all changes made to it.

The printer button on the form produces the Team Tasking report.

Logs

The Log screen is often considered to be the most important part of IMan.
This is where all the data related to the Incident is stored so that it can be
located via the search processes. Changes made to Teams and Tasks are
automatically recorded as Logs so they can be part of the search results.
One of the management objectives during a search should be to get the
collection rate for data as high as possible. Often during an Incident there is
so much happening that the recording of the information is given a low
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priority. Then when a shift change occurs important information is lost with the
departure of the outgoing team.

To overcome this natural human tendency to store things in ones head rather
than in the computer system requires a determined effort by the entire
management team. The appointment of people responsible for information
collection and management is worthwhile. We call them Search Assistants or
Information Officers in NZ.

The Log Search/List Screen

As is common with other screens the search area is at the top of the screen
and the details for the selected Log entry are displayed at the bottom.

The search area at the top confuses some new users who expect that when
they type into this area it will allow them to create or edit a log entry. Some
training or guidance for new users is helpful on this.

The selected log entry can be opened by double clicking, a right mouse click
or pressing Ctrl E.

The Log Search

There are two versions of the search screen — the Standard and the
Advanced. When the program first starts it goes to the Standard search.
Some useful features of the Standard search:

Page 19




The Hide System Logs tick box can be used to remove the system
generated log messages from the list. This includes Log entries related
to Teams and Tasks.

The selection of the AND or OR options is the same as on the
File/Options screen. A change on the log search will also change the
setting on the File/Options screen.

The Result(s): 12 of 128 provides a useful guide to the effect of the
search. The highest number indicates the total number of Log entries
on the system.

The High Ranking Area

The red part of the search area lists those Log entries with a high Ranking.
This high Ranking does not mean the use of the word high. It means that for
the available Ranking options (as set in the Admin area) the items with the
word Highlight ticked will automatically be added to the High Ranking Area
and provided also there is an entry in the For Action By (Role) field.

Clicking on an entry in the High Ranking Area will automatically activate an
Advanced search for the selected Role. The number of Log entries displayed
should match the numbers shown in the High Ranking Area.

To return to the normal search click the Clear button of the Standard button.

The Advanced Search Facility

This provides huge flexibility for searching for specific Log entries however it
does require more effort to understand than the simple search.

To help users understand the Advance Search four sample filters are
provided. Using these filters it is possible to make changes then save the
changes to a new filter. Unwanted filters can be deleted using the X button.

The words in blue indicate that the values can be changed. There are drop-
down lists for selecting the values
— these include all fields available
and the criteria (as shown).

Click on the button to the left
of the tick box to add a new
criteria line.

Untick an item to exclude it from
the search. A line can be deleted
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by clicking on the  button and selecting Remove.

The Log Screen

The only required field when a new record is created is Summary. The
position of this field on the screen shifts when a new Log is first created.
When a new Log is created (usually by pressing Control N) the Summary field
shifts to below the Details field. When the record is saved the first 50
characters from the Details are copied to the Summary, provided the
Summary field is empty.

The From and To fields use the abbreviations set on the Teams screen, or a
value can be selected from the drop down list, or a value can be typed in. The
drop down list symbol does not appear until you click on the field with the
mouse.

Default values can be set on the File/Options screen for the following: From,
To, Type, Status, Ranking and For Action By. Thus each time a new Log is
created it can have one or more of those values set automatically. These
defaults can be set on the File/Options screen for every computer (Global) or
only the local computer.
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Also the values in the drop down lists for the Status, Ranking and For Action
By fields are set in the Admin area. Any value can be typed in if the drop
down options are not appropriate. The For Action By drop down list comes
from the Roles list in the Admin area.

Local conventions or rules should determine who has the authority to update
these fields.

The Date Logged field is automatically filled with the date and time the Log
was created. Similarly the Created By field stores the user name and role of
the person who created the entry. This is one of the reasons that each user
should have their own login and password.

The Date and Time of event are entered as needed. Sometimes details are
entered as they happen in which case the default date/time can be accepted.
However when the data is entered after the event then the date and time must
be adjusted. The button to the left of the time field changes the entry to the
current time, whereas the button on the date field pops-up a calendar which
can be used to pick a date.

Grid References

Although designed primarily for map grid
coordinates this screen can also handle
Latitude and Longitude.

The Map GR and GPS GR buttons are used
to indicate the source of the data. Some
teams are trained to only report their location as a six digit map reference
even though they have derived the location from a GPS. Using 6 digits in this
way significantly reduces the radio traffic. By recording the source of the data
the Management Team can later request the full 14 digit GPS coordinate if
they need it.

The  button allows the selection of a location from the locations list
originating in GMan.

The first (and smaller) GR field is designed to take a 6 digit GR. This will then
be automatically converted to a 14 digit GR provided the two preceding digits
for Northing and Easting are entered into the Incident Details screen.

The reverse calculation will also occur when a 14 digit GR is entered or
updated. The 14 digit GR should be in this format for the reverse conversion
to occur 1264564, 1234567.

If the Northing and Easting values have been set or changed after some 6
digit GR values have been entered then a reconversion can be forced by
holding the shift key and left mouse clicking on the GPS GR field.

The Details and Actions fields have Zoom buttons that enlarge the typing
area. Both of these fields can store an unlimited quantity of data hence the
benefit in being able to enlarge the data entry window to full screen size.
Double clicking in the field area also opens the Zoom window.

These fields do not support different fonts or colours.

The Cross Ref No is used to store the unique number from the radio
message forms. Similarly the Log ID (Ul) can be written onto the message
form providing a useful cross reference for future audits of the data.
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The Standby and Suspend tick boxes will both cause the Log item to flash
on the Log List screen. The Standby option flashes with a yellow background
and Suspend with blue. The purpose of these two buttons (and all other
buttons) can be allocated by local convention however a common use for the
Standby button is to indicate when a team in the field has been asked to
Standby for a response from Base.

The Flag field, when ticked, causes a green flag to be displayed in the first
column of the results list.

The File Reference field stores a link to a file. This can be any file type which
can be opened on the computer including Word, Excel, photo (jpeg) and video

(mpeg) files. Click on the  button to select a file and the Open button to
view/edit it.

The printer icon will preview a detail report for the current log entry.

The Audit Log tab is used to view the changes made to the Log since it was
first saved. The Zoom Details of the selected record  button below the list is
used to display more details. This is especially useful when the changed item
has multiple lines such as with the Detalils field.

Save Options

The Save Buttons allow for a variety of options.

The Save, Create Copy button will make a copy of the existing Log. The new
log entry will have the Ul, Created By and Date Logged fields will be updated
but all other fields will remain the same. The Audit Log screen will be blank for
the new entry.

The Save, Create New button will save the changes made to the current Log
then close it. A new blank log will then be created and opened.

The Save, Close button saves any changes that have been made and closes
the current Log.

The Save button saves and changes that have been made but leaves the Log
open.

The Cancel button will discard any changes that have been made and close
the Log.

Clicking on the Windows X (top right corner) to close the Log will always open
a dialogue to check that changes should be saved. This happens even if no
changes have been made.

The T3 Button

Near the 14 digit grid reference field is the T3 button. Provided an icon has
been specified for each team (on the Edit Team screen) then a click on the T3
button will place the specified icon on the TUMONZ map. This will only work
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for a valid 14 digit grid reference and if TUMONZ is installed on the same
computer.

The reference to the Icon is on the TUMONZ My Data tab at the bottom of the
tree, called Temporary Data. The entry will show the team name plus the date
and time that the T3 button was clicked. To make the icon permanent right
mouse click on it (in Temporary Data) and select Make Permanent . This
action will copy it to the User Icons section of the tree under SDK App and the
Team name or IMan and the Team name.

If the T3 button on IMan is clicked multiple times then multiple copies of the
Icon will be created.

To remove the Icons placed on TUMONZ by IMan the IMan program needs to
be shut down and restarted.

Admin Area

The screens associated with the Admin Area populate the drop down lists,
setup the default teams and manage users. Only users with admin rights can
make changes in this area.

The purpose of this area is to allow IMan to be customised to the terminology
of the local area. It also allows IMan to be applied to events run by
organisations other than Search and Rescue, such as Civil Defence.

The first seven icon options (down to users) require a double click or right
mouse click to open the edit screen. Also Control N is used to create a new
entry.

All the drop-downs in the Other Combos area are set by typing directly onto
the list.

In the Edit Users screen each user should be setup with their own username
and password. This allows the audit log to store the reference to the user who
made each change. The two security levels are Administrator and Normal.
Only Administrators can make changes in the Admin area.

The other setting available for each user is the Access Options tick box . If
this is not ticked then the user cannot open the Options screen under the File
menu.

Steps in Starting a New Operation

The sequence of steps in starting a new operation may vary depending on the
skills resources and equipment available at the time. However, we have
found that each operation tends to roughly follow the procedure below.

Create a blank database file

Start Logging all messages

Import Resources from GMan if not copied across

Create Team Names and shortcuts if not created from defaults

Add Users and passwords and ensure that each user logs in

Add more computers to the network as needed

Check in people and equipment

Create teams and Tasks

Ensure that all messages, interviews, phone calls etc are
recorded.
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Networking and Data File Sharing

IMan has been designed for easy installation and networkability.

The database can have an unlimited number of computers connected to it at
the same time. The most computers we have had using a single database on
a search is 22. There were no performance problems with this number.

The computer with the data file on it is usually referred to as the server
computer.

To connect another IMan computer to the server the machine needs to be
able to see the server in the Network Neighbourhood area of Explorer. If the
drive of the server computer is Mapped on the local machine as say Z: then it
will be easier to make the connection and reconnect if the connection is lost.

From experience the best location for the server computer during an operation
is with the radio operators as this area should always be manned.

Server Computer Considerations

The preferred operating systems for the Server computer are Vista Business,
XP Professional and NT 2000.

XP Professional will only allow 10 computer connections but this should be
ample for most operations.

XP Home will only allow 5 computer connections but is otherwise OK.

Win 98 is likely to cause database corruption and should be avoided.

A slow server computer will cause performance problems — the data should
be on the fastest available machine.

Avoid using Wireless networks for more than 2 remote computers otherwise
network performance may suffer. If using wireless ensure that the path name
to the database file is short — less than 12 characters.

Consider using a UPS for the network switch/hub and projector. This is

important if the power supply is likely to be unreliable. It assumes that the
server machine is a laptop with its own battery supply.
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Registering IMan and GMan

Registering IMan

To install IMan you need the full install file which can be downloaded from the
Datasolve Web Page at www.datasolve.co.nz or www.giman.co.nz . The initial
install provides a Trail period of 60 days. There is no need to contact
Datasolve to start the trial.

To run the trial version you should press Ok button on the first screen that
tells you it is a Trial, and you have 60 days left.

This will start the trial period of 60 days. The program will be fully functional
during this period — the only difference from the full (registered) product being
the reminder screen (as below) which appears every time you start the
program.

To register IMan you need to send the Registration Number to Datasolve Ltd.
The best way to do this is by email to info@datasolve.co.nz. A payment is
required for the registration of each copy.

The registration number is displayed in a Red box on the first screen that
comes up when using the Trial version. Even if the Trial is expired you will get
the initial Trial Registration Wizard screen.

Once you have paid for the license you will receive an Unlock Code. When
you have received the Unlock Code you can start IMan again and press the
Next button.
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Enter the Unlock Code into the Green box.
When you click OK you will get a message to say that your copy has been

upgraded to Retail.

Registering GMan

The process is identical to that for IMan. To install GMan you need the full
install file which can be downloaded from the Datasolve Web Page. The initial
install provides a Trail for 30 days.

To run the trial version you should click the Ok button on the first screen that
tells you it is a Trial, and you have 30 days left.

To register GMan you follow the same procedure as above for IMan.
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